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8 Format Editor 

The Format Editor allows the creation and editing of the log presentation or format files. The output of 
the format editor are files of the type *.prs which are subsequently used to control all aspects of the 
log format. The Format Editor may be started in three different ways: From its icon in the Warrior 
group box, when started from the Warrior program group the Format Editor window appears as 
shown below, i.e. with no presentation available for edit  

FIG: 8.1 Select Format Editor 

The Format Editor may be started from its icon in Warrior shortcut folder, from the Edit menu of the 
Acquisition or Recalculation modules, from the File menu of the Presentation Plot module, or from 
the Action menu of Interactive Plot. In addition, double-clicking in the scales area of the Interactive 
Plot window will also start the Format Editor. 
When started from Warrior shortcut folder or from Presentation Plot, the Format Editor window 
appears as shown below, i.e. with no presentation available for edit. If started from the Acquisition, 
Recalculation or Interactive Plot modules, the log format currently being used will be presented. 
Displays a file selection window showing all the presentation files, currently available, within the 
system. The operator can select the presentation file to be edited. Note that all presentation files are 
to be found in the \warrior\format directory and have a prs extension. 

Section

8
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FIG: 8.2 Select Format 

 

FIG: 8.3 Open Format 

From the Acquisition or Recalculation modules select Edit menu (Master Log Format) the log format 
currently being used will be presented 

FIG: 8.4 Select Master Log Format 
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FIG: 8.5 Edit Format 

From interactive plot select Action\Screen Plot menu. In addition double-clicking in the scales area of the 

interactive plot window will also start the Format Editor. 

 

FIG: 8.6 Interactive Plot 
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FIG: 8.7 Select Action/Screen Plot 

 

FIG: 8.8 Double Click over the header  

 

FIG: 8.9 Edit Presentation 
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8.1 File 

 

FIG: 8.10 File option 

8.1.1 Select Dataset 
Select Dataset from Database for specifically Log pass 

8.1.2 Import ASCII Files 
See Section 12.3.1 Read ASCII data into Warrior 

8.1.3 Export to LAS 
See section 12.1.1 Export to LAS Format. 

8.2 Options 
Allows selection of various presentation options as shown below. 

 

FIG: 8.11 Options 
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Start and Stop depths can be selected or the full range of the database can be selected using the 
Maximize button. 
Alternative presentation files may be selected using the Browse button, which brings up a standard 
file selection box. Warrior log format information is contained in individual files with a prs extension. 
These files are created or edited using the Log Format Editor program. 
Note that a selection can be made to Use a private copy of presentation with this log. This 
embeds the current presentation file in the database so that the database can be archived complete 
with its presentation or sent to other Warrior systems without having to remember to send the 
presentation file along with it. Also, if the presentation is embedded and it is subsequently edited from 
Interactive Plot, the edit will only take place on the embedded copy, not on the original file. English
or Metric depth units may be selected, or Time can be used as a reference. The log may be plotted 
Up or Down. The log data units may be selected as English or Metric, or you may define a hybrid 
system. The User Defined units setup is done from with the Control Panel. Whenever a parameter 
in the Options window is changed, the current log screen plot(s) will be redrawn with the new option. 

When an option is changed, ALL interactive plots are redrawn. This can be a 
heavy load on the computer if a large number of CBL-VDL plots are currently on 
the screen and with a slow machine it may look as though the system has halted. 

Select the depth to Start/Stop to Plot the LOG 

Select presentation from the Warrior\Format (directory). 

Select Vertical Scale by default is 1:240 (5” = 100’) or (1’ = 240 ‘) 

8.3 Edit 

8.3.1 Log Format 
Provides rapid access to the Log Format Editor. When the Format Editor is invoked from Interactive 
Plot, changing the log format and saving it causes the active screen plots to be replotted with the new 
format. Note that many screen plots may be overlaid on each other at any one time. If a large number 
a plots are present, a noticeable delay will occur while all are replotted. 

 

FIG: 8.12 Log Format 

8.3.1.1 File 
The Format Editor allows the creation and editing of the log presentation or format files. The outputs 
of the format editor are files of the type (*.prs), which are subsequently used to control all aspects of 
the log format. 
The Format Editor may be started from its icon in Warrior shortcut folder, from the Edit menu of the 
Acquisition or Recalculation modules, from the File menu of the Presentation Plot module, or from 
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the Action menu of Interactive Plot. In addition, double-clicking in the scales area of the Interactive 
Plot window will also start the Format Editor. 
When started from Warrior shortcut folder or from Presentation Plot, the Format Editor window 
appears as shown below, i.e. with no presentation available for edit. If started from the Acquisition, 
Recalculation or Interactive Plot modules, the log format currently being used will be presented. 

 

FIG: 8.13 File 

8.3.1.1.1 New 
If a log format is currently selected for editing, New clears the editor for a new log format. 

8.3.1.1.2 Open 
Displays a file selection window showing all the presentation files, currently available, within the 
system. The operator can select the presentation file to be edited. Note that all presentation files are 
to be found in the \warrior\format directory and have a (*.prs) extension. 

8.3.2 Layout 
Allows selection of the log grid layout from a selection, supported within the logging system. 
The Warrior system is delivered with most standard layouts included. If you require a grid layout that 
is not available within layouts select Edit Layout to construct your own. 
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FIG: 8.14 Layout options 
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FIG: 8.15 Layout Editor 

8.3.3.1 OPEN 
Select Database for Format presentations. 

FIG: 8.16 Select Presentation 
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Select Object / Add Data or click the Add button.

 

FIG: 8.17 Object 

 

FIG: 8.18 Select Curve 
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8.3.3.2 Data source 
Define the Data Source. Select the DB Item by using the Quick Pick list button or by typing the 
item name directly into the DB Item field.

FIG: 8.19 Select Curve 

Not all database item names are available from the Browse button. In a given service, use 
Monitor/Outputs to see all curves, or Edit/Variables to see all variables. 
Define the data item as a Variable or a Data (curves, waveforms, etc.), using the radio buttons so 
marked.

8.3.3.3 Position 

FIG: 8.20 Set Position 

Define the track, where the curve is to be presented, by typing the track number directly into the 
Track # box or by using the arrow buttons. The track numbers are indicated in the power section of 
the main Format Editor window. 
Define the Left value and Right value of the curve. 

8.3.3.4 Presentation Type 
Define the Presentation Type. Depending on the Presentation Type chosen, the right hand side of 
the Define Data Item window, or Style section, will present different options. 

8.3.2.4.1 Curve 
Define color (for color graphics devices only). If required, select Wrap. Causes infinite left and right 
backup curves to be presented. 
Selecting wrap causes backup traces to be generated, however the backup scales are not labeled, 
nor is there any control over the trace thickness or coding. Adding another curve with the same 
output name, but with different scales, etc., allows complete control of the attributes of the backup 
curve(s). 
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FIG: 8.21 Set Presentation Type 

If required, select Label. Allows the standard database mnemonic in the log scales header to be 
replaced by a text string. For example, GR may be replaced by Gamma Ray. Enter the text string in 
the Label field.
If the curve is to be presented on a logarithmic scale, select Logarithmic.
Select the required curve thickness and curve coding. 
Click the OK button.

8.3.2.4.2 Tabular 

FIG: 8.22 Tabular Style 

Define the position of the tabular number with the track, previously selected, as Left, Right or
Middle. Define the required decimal point display. 
Define the depth interval at which the tabular number is to be printed, i.e. every xx ft. 
Note that the numerical depth, displayed in the depth column, is a tabular depth curve, and its 
presentation may therefore be modified in the same manner as any other curve. 
Enter the required label for the log scales header in the Label field.
Click the OK button.

8.3.2.4.3 Variable Density 
In the Style section, set the VDL Black Level and the VDL White Level parameters. These 
parameters set the level at which the (acoustic) waveform will appear as black or white on the log 
output. The normal range of the digitizer is plus and minus 5 volts. Therefore, with the levels set at 
25% as shown below, any signal above 1.25 volts will appear black, and any below minus 1.25 volts 
will appear as white. The number of levels of gray, defined by the color map, is set evenly between 
these two limits. 
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FIG: 8.23 VDL Style 

Enter the required label for the log scales header in the Label as field.
Enter the name of the required Color Map in the Color Map field. The color map controls the number 
and appearance of gray shadings or colors used in the VDL presentation. Various color maps may be 
defined the in the Warrior.ini configuration file. 
Click the OK button.

8.3.2.4.4 Signature 
In the Style section, set the Signature Height and Interval parameters. The Signature Height sets the 
vertical (or y-axis) size of the waveform in inches of paper. As mentioned previously, the range of the 
digitizer is 10 volts peak to peak; therefore the Signature Height parameter normally corresponds to this 
range of raw waveform signal. The Interval parameter defines how often the waveform is printed on the 
output in feet or meters 

FIG: 8.24 Signature Style 

In the Style section, set the Signature Height and Interval parameters. The Signature Height sets 
the vertical (or y-axis) size of the waveform in inches of paper. As mentioned previously, the range of 
the digitizer is 10 volts peak to peak; therefore the Signature Height parameter normally corresponds 
to this range of raw waveform signal. The Interval parameter defines how often the waveform is 
printed on the output in feet or meters. 
Choose: 
No Shade or Shade Pos. or Shade Neg. 
Select Normalize and/or Logarithmic, if required. Normalize amplifies the maximum peak to peak 
reading of each waveform to the maximum set by the Signature Height parameter. Logarithmic 
displays the waveform on a logarithmic vertical scale. 
Enter the required label for the log scales header in the Label field. 
Click the OK button. 
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8.3.2.4.5 Pattern Strip
Pattern Strip is a curve presentation, similar in appearance to a VDL, except that it has only one 
value at a given depth. For example, a Gamma Ray curve might be represented as a narrow track, 
where high values of gamma ray were shown as black and low values as white, with intermediate 
values shown as varying shades of gray. 

 

FIG: 8.25 Pattern Strip 

Select Label in Scale Type if a user defined Label is to be used. 
Enter the desired curve label in the Label field.
Define the Color Map in the same way as a VDL presentation. 
Click the OK button.

8.3.3.5 Add Shading 
 

FIG: 8.26 Add Shading

Click on Object/Add Shading. A dialog box appears as shown below. 
In the Left Boundary section, enter the name of the curve, with which the shading is associated. 
If it is desired for the left boundary of the shading to follow the curve, select Follow Curve. If it is 
desired for the left boundary of the shading to follow a constant value, select Constant and enter 
value of the constant in the units of the associated curve. In the Right Boundary section, repeat the 
steps above. Select the required shading pattern by clicking on the pattern itself, and select the color 
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by choosing from the list in Foreground. If you wish the grid to show through the shading, click on 
See Through.

FIG: 8.27 Shading 

To see more patterns, left-click and hold the mouse on a pattern, then move the 
mouse to the right or left. The patterns will then scroll, showing more of them. 
Click the OK button.

8.3.3.5.1 Change & Remove Shading 
Click on Object/Select Data or Shading. A list of the objects is presented. 

FIG: 8.28 Select Data or Shading 

FIG: 8.29 Chose an Item 
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Double-click on the object to be changed, the window disappears, and then click on the Change 
button. The shading setup window appears as before, allowing changes to be made. 
A shading object may be similarly removed by clicking the Remove button, once the object has been 
selected. 

FIG: 8.30 Remove & Change Shading 

Currently, there is no possibility to identify which curve is selected when a curve 
is presented more than once (e.g. multiple curves with different scales). In a 
CBL, for example, if AMP3 is resented twice on the log, then AMP3 will appear 
twice in the list of plot objects. The only way of distinguishing them is by trial and 

error, or that, when curves are added by the format editor, they appear at the bottom of the object list. 
So if AMP3 (scale 0 to 100) was added first, it will appear above AMP3 (scale 0 to 10) in the object 
list. Of course, when looking at an existing log format, this method cannot be used to distinguish 
them.

FIG: 8.31 Show Shading 

Show the shading in the header ON/OFF 

8.3.3.6 Enable Curves For Zone Scaling 
Occasionally it is required to alter the plotted scales of a curve in different zones. This can be 
achieved by selecting the Zonable Scales checkbox when defining a data item. 
Select the curve that requires zone scales by highlighting it in the format editor and clicking the 
Change button. 
Select the Zonable Scales option and the ZSC Name textbox appears in the bottom right hand 
corner. The default variable name can be overridden by entering a name in the ZSC Name box; in 
this case "GAMM" has been entered as an example. 
Selecting the Zonable Scales option creates two new special types of variables in the dataset, in this 
case L_GAMM and R_GAMM. These can be zoned during Interactive Plot by selecting the Zoned 
Scale Changes option in the Edit menu: 
Add a new Zone by clicking the Zones button and enter the depth at the change. 
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Multiple curves from the same DB item can have separate ZSC controls, e.g. when a main GR and a 
backup GR curve is available. Leave the ZSC Name blank for the main curve, but enter GRBU for 
the backup curve. This will still show two curves plotting from the DB item GR, but the ZSC editor will 
present L_GR, R_GR, L_GRBU and R_GRBU controls. 
Note: a curve may be turned off over an interval by selecting its right and left scales to be equal over 
the desired zone. 

 

VIDEO: 8.1 Master Log Format 

8.3.3.7 Minute Marks 
 

 

FIG: 8.32 Setup MINMK 

Add MINMK curve and set the presentation. 
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FIG: 8.33 Edit MINMK 

In Utilities select Edit services Details and Edit Sensor 
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FIG: 8.34 Plot MINMK 

 

8.3.4 Color Maps 
In Warrior, there is a section labeled [Color Maps]. Color maps that are to be selected from the format 
editor are sequentially numbered under this heading. 
Under each plotting device (including the SCREEN) the colors or shading for that device will need to 
be defined or that map will not print for that device. 
For monochrome maps, the shading for a device is defined by the number of shades N, followed by 
N numbers with ranges from 0 to 255. 0 will be all black and 255 will be white. Grayscales=5, 0, 
64,128,192,255 
For color maps, the shading for a device is defined by the number of colors N, followed by N groups 
of three numbers. Each group of three numbers {R,G,B} are intensities of red, green, and blue. 
These numbers also must be in the range of 0 to 255. 
Colors01=5,{0,0,255},{1,228,254},{2,253,97},{115,253,2},(255,255,0}. 
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FIG: 8.35 Color Map 

 

VIDEO: 8.2 Color Maps 

8.4Action

8.4.1 Screen Plot 
See section 9 

8.4.2 Hardcopy 
See section 9 

 

FIG: 8.36 Action 



224Warrior Software Version 7.0 Standard Cased Hole 

8.5 Tools 

 

FIG: 8.37 Tools 

8.5.1 Depth Shift a Curve    

See section 12.4.2 

8.5.2 Depth Shift Whole Pass 
See section 12.4.1 

8.5.3 Run TVD/Merge Program 
See section 11.3 

8.5.4 Create an Alias 
See section 12.5.1 

8.5.5 Run Auto Merge Utility 
See section 12.5.2 

8.6 Pause/ Unpause 

 

FIG: 8.38 Pause/Unpause 
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8.7 Annotations 
Allow you to place annotations, curve labels and graphical objects on the log. 

 

FIG: 8.39 Annotations 

Scroll the log to the area where annotations are required and select Annotate from the Action menu. 
Note that annotations may be placed on the log even whilst logging. Simply 'Pause' the scrolling log, 
scroll back to the area where the annotations are to be inserted, place the required annotations and 
'Unpause' to return to the current logging depth. 

 

FIG: 8.40 Annotate 
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8.8 Log Banner 
Ensure that the pass, to which the banner is to be attached, is selected in the active plot window. 
Select Edit/Log Banner, and if required a database and dataset. 
Clicking on the File menu and clicking the Select can select the format of the Log Banner Format… 
option. There are a number of Log Banner formats (*.Wlb) to choose from. Select the most 
appropriate format and the edit the details by clicking on relevant areas within the window. 

 

FIG: 8.41 Log Annotations  

 

 

VIDEO: 8.3 Annotations 



227 Warrior Software Version 7.0 Standard Cased Hole

8.9 Well Sketch 

 

FIG: 8.42 EDIT\Well Sketch 
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Run Interactive Plot and select the dataset to accompany the well sketch. Click Edit/Well Sketch and 
the window, shown below, appears. 

 

 

 

 

FIG: 8.43 EDIT \ Well Sketch 

To add a new well object, select the object you wish to insert from the toolbar. A dialog window 
opens where the selected object’s properties are defined. 

 

 

FIG: 8.44   Tubing Setup 

Attachable' objects should be inserted first. Once these objects are added a list of 'attachable' objects 
is generated. Additional items can be added at this stage. 
To edit or delete a well object, double-click on the object or press <Ctrl> and click to select more than 
one item. Right click opens the popup menu where the edit or delete options are available. 
Selecting the area between the column headings and dragging to resize can change column widths. 
Columns can be sorted by clicking on the column heading. 
Nipples & Packers, etc. can be added at a single depth, however if a well object appears at various 
intervals enter the depths and range in the Depth Interval(s) textbox, e.g. 0.00-200. 
Continue adding objects until all required objects are entered, then save the well sketch by clicking 
File/Save or Save As….
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FIG: 8.45   Well Object Editor 

8.9.1 Depth Intervals 
The following are examples of valid depth intervals: 
A semicolon or a space separates each depth interval. Top and bottom depths of one depth interval 
must be separated by a dash. 

8.9.2 Annotations 
You can automatically annotate your well object by typing in the annotation here. If the annotation is 
moved to a different position, it becomes a normal log annotation and will no longer show up here. 

8.9.3 Vertical Position 
The position of the well object is defined as a offset percentage from the left and right hand sides of 
the track. Values less than 0 and or greater than 100 will draw part of the object outside of its 
assigned track. A scale of -100 to 0 will place the object entirely outside of its assigned track at a 
width equal to the assigned track. 

8.9.4 Width 
The objects in the diagram will be drawn proportionally to each other. If a size is entered, then the
left and right vertical position will be calculated to draw that object centered in the diagram. If the left 
and right scales are changed, the size will reflect the change. 

8.9.5 Inflation Factor 
The width * Inflation factor will be the actual size of the object drawn on the diagram. If the width is 
changed, the inflation factor is set back to 1 (100%). 

8.9.6 Attaching Objects 
If a bridge plug object is attached to a casing object, then the bridge plug scales and size will be fixed 
to the scales and size of the casing object. If the casing size and/or scales are changed, the bridge 
plug settings will reflect that change. 

8.9.7 User Defined Metafiles 
Any metafile can be used as a well object by placing the metafile in the 'Warrior\Format' directory with 
an extension of 'wwd'. The new object will be displayed on the toolbar with the same name as the file 
without the extension. 

8.9.8 Metafile Properties 
Metafiles can be displayed as either Fixed or Stretched. The fixed mode can display the graphic in its 
original proportions using three different methods. Center will center the object about the center of 
the interval. Top will start drawing the object at the top of the interval. Bottom will draw the object so 
the bottom of the object will be at the bottom of the interval. The stretched mode will stretch or 
compress the graphic to fit within the depth interval. 
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In order for the well sketch to appear on the log, open the Log Format Editor and Add a database 
item, called wellobj, to the log format. 
Click the Graphic Strip radio button and select the track where the well sketch is to be presented. 
In our example the result is as shown in Fig: 8.44 

 

FIG: 8.46 Plot LOG

 

VIDEO: 8.3 Well Sketch Editor 
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